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Use this guide for your first steps with the Agilent 6400 Series Triple Quad LC/MS, and as a
road map for your user information.

What is the Agilent 6400 Series Triple Quad LC/MS system?

The Agilent Triple Quadrupole LC/MS is a liquid chromatograph triple quadrupole
mass spectrometer that performs MS/MS using three sets of parallel rods (in this
case, quadrupole, hexapole, quadrupole). The first quadrupole separates ions into
precursor ions that are fragmented in the hexapole into product ions, which are
separated by the second quadrupole. Often, two or more precursor ions and their
product ions are monitored in sequence in MRM (multiple reaction monitoring)
mode. You can monitor up to 4000 MRM transitions by using Dynamic MRM.

The Agilent 6490 and 6495 Triple Quadrupoles contain the iFunnel Technology
which provide more efficient sampling of ions into the mass spectrometer. The
iFunnel Technology includes the Dual Offset lon Funnel and these other
technologies: the Agilent Jet Stream Technology, and shorter desolvation assembly
with Hexabore Capillary.
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The Agilent 6495, 6490 and 6460 Triple Quad LC/MS are shipped by default with
the Agilent Jet Stream Technology that utilizes a super-heated sheath gas to
collimate the nebulizer spray which dramatically increases the number of ions that
enter the mass spectrometer.

You can set up an Agilent Triple Quad LC/MS with the Agilent 1100, 1200, 1260 or
1290 Infinity LC modules.

Also, the Agilent Triple Quad LC/MS comes with Agilent MassHunter Workstation
Software that includes three major programs:

e Data Acquisition — From one screen you can tune the mass spectrometer,
control and monitor instrument parameters, set up acquisition methods and
worklists containing multiple samples and monitor real-time run plots.

* Quantitative Analysis — From one screen you can set up a batch of data files and
quantify, evaluate and requantify the results. From this screen you have access
to the Method Editor for setting up and editing the quantitation methods.

* Qualitative Analysis — From one screen you can extract and integrate
chromatograms, subtract background, extract peak spectra, and compare data
from different types of data files.

What's New in Data Acquisition

The Data Acquisition program for the 6400 Series Triple Quadrupole has many
new features in this revision.

in B.07.02

* The supported models are 6420A, 6460A, 6460C, 6490A, and 6495A.
¢ Agilent MassHunter StreamSelect version B.07.00 is supported.

e This version is intended only to be used with StreamSelect.

in B.07.01
¢ The supported models are 6410B, 6420A, 6430A, 64604, 6460C, 6490A, and
6495A.

¢ The Agilent 6460A Option 100 is supported. The 6460A Option 100 is a twin
turbo QQQ that uses the standard ESI source instead of the AJS ESI.

¢ The Agilent 1260 Infinity Analytical SFC (supercritical fluid chromatograph) is
supported.

e The Agilent 1290 Multisampler is supported.
* The Agilent 1220 Compact LC is supported.

Agilent 6400 Series Triple Quadrupole LC/MS Quick Start Guide



e The Agilent 35900E Series 2 is supported.

¢ The Agilent Pump Valve Cluster is supported.

e The Agilent Column Compartment Cluster is supported.

e The Agilent HDR-DAD Cluster is supported.

¢ The Agilent 1290 Quaternary Pump is supported.

e The Agilent 1290 VWD is supported.

e The Agilent 1290 MCT (Multicolumn Thermostat) is supported.
e The Agilent 1290 DAD is supported.

e The Agilent 1290 Infinity II DAD FS is supported.

e The Agilent 1290 Binary Pump is supported

¢ The Agilent 1260 Multisampler is supported.

e The HTS/HTC uses RC.NET driver with new device configuration capabilities.
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Where to find information

Where to find information

Help
Press F1 To get more information about a pane, window or dialog box, place the
cursor on the part of the pane, window or dialog box of interest and press F1.
Help menu From the Help menu, access “How-to” help and reference help.
Documents

You can open user and installation/upgrade guides from the online Help if they are
installed from the Data Acquisition installation disc.

You can open installation/upgrade guides from the Data Acquisition installation
welcome screen.

All of these guides are available on the installation disc, in the Manuals folder.

Some of these guides are also included with your system in printed format.

Installation Guide This guide is used to install the hardware and software,
configure the instrument, and verify performance.

Upgrade Guide This guide is used to upgrade your MassHunter Workstation
software from a previous version.

Maintenance Guide Use this guide to help maintain and troubleshoot your
Agilent Triple Quad LC/MS.

Concepts Guide - The Big Picture Learn the background information to help you
understand operation of the hardware and software.

Data Acquisition for 6400 Series Triple Quad Familiarization Guide Do the
exercises to learn to use the Triple Quad LC/MS hardware and Data Acquisition

program for 6400 Series Triple Quad.

Study Manager Quick Start Guide Use this guide to learn to use the MassHunter
Study Manager software.
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Where to find information

MassHunter Optimizer Software Quick Start Guide Use this guide to learn about
the MassHunter Optimizer program. The MassHunter Optimizer program provides
a way to automatically optimize the data acquisition parameters for MRM mode
(multiple-reaction monitoring) on a Triple Quad instrument for each individual
compound analyzed.

MassHunter Data Acquisition Compliance Software Quick Start Guide Use this
guide to learn about the MassHunter Data Acquisition Compliance program.

MassHunter Quant Compliance Quick Start Guide Use this guide to learn about
the MassHunter Quant Compliance program. (This guide is on the Quantitative
Analysis disc.)

Qualitative Analysis Familiarization Guide Do the exercises to learn to use the
Qualitative Analysis program. (This guide is on the Qualitative Analysis disc.)
For information on what is new in the Qualitative Analysis program, refer to the
Qualitative Analysts Familiarization Guide.

Quantitative Analysis Familiarization Guide Do the exercises to learn to use the
Quantitative Analysis program. (This guide is on the Quantitative Analysis disc.)

For information on what is new in the Quantitative Analysis program, refer to the
Quantitative Analysis Familiarization Guide.

Training

Familiarization Guide Use all three familiarization guides to get to know the
software.

Quick Start Guide Use the quick start guides for Study Manager, Optimizer and
Compliance to get to know these programs.

Training Courses Visit www.chem.agilent.com to view a listing of training courses
for the Agilent Triple Quad LC/MS.
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Getting Started

Getting Started

Install the Triple Quadrupole LC/MS hardware and software

Use the Installation Guide to install the hardware and software and verify
performance.

Set up, run, and analyze samples

The roadmap below shows you the steps to set up and run a batch of samples from
start to finish. Follow the instructions on the next pages to get started and to learn
where to find the information to help you with each step in this roadmap.

—» 1 Startthe 2 Prepare the

Start Data LC modules.

Here! Acquisition

software. ¢
3 Prepare the
| Triple Quad
1 and : instrument.
]

6 Analyzedata | B Review 4 Setupand
with results with T run an
Quantitative Qualitative acquisition
Analysis. Analysis. method.

6 Agilent 6400 Series Triple Quadrupole LC/MS Quick Start Guide



Getting Started

Step 1. Start the Data Acquisition software

The instructions below include the following assumptions:
e The hardware and software are installed.
e The instrument is configured.

Use instructions in the Installation Guide to configure the instrument for the
first time and any time you change the LC configuration.

The LC modules and the Triple Quad MS are turned on, but the LC pump is not
running.

After installation, you see all of the Agilent MassHunter Workstation Software
icons on your Desktop. To start the Data Acquisition program, double-click the
Data Acquisition icon.

The Data Acquisition window appears.

B Agilent MassHunter Workstation ] 5|
( j\: ;. ‘ .~ Agilent MassHunter Workstation ~ v |23 [ search Aglent MassHunter Workstation [#2)
Organize v Indudeinlibrary *  Sharewith ¥ Burn  New folder i# o~ O @
# Favorites | @
| | ‘ | ¥
Libraries 25 o (= Ll
= AcgTools  Qualitative  AcqSystem  Acq System Data Offine
‘Analysis Launcher Logbook Acquisition Method
8.06.00 Editor
& Homegroup i
. S N 1
7% Computer @ E
- =mi
(@[ P= e
1 € Netwark Offiine Optimizer for Optimizer Qualitative Source Study

Worklst Peptides Analysis Optimizer Manager
Editor B.06.00

12 tams State: 2 Shared

When Data Acquisition opens, the software engines automatically
start. If you need to restart them, right-click the Acq System
Launcher icon in the system tray, and click Start Engines.

If you have recently changed LC modules, remember to configure the
instrument again. See the Installation Guide for instructions.

Library
Editor
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Getting Started

Instrument Status
window

[ Agilent MassHunter Workstation Data Acquisition)
Fle View Sample Workist Method Thols Help

Context: | Acquisition Loyout: [Defautcdriye ) 9 - | 2 DIEEDIED) Method: | QQ_Eample.m Waorklist: B
 Instrument Status. ; Actuals x
09 ¢ rnl 00  © rnll 09 O rnll 00 | @ Run I © © Run 000: Not Ready Test Long
2 - 000 Gas Flaw 120U
2 =
P halcd G ] ] L g7 Q00 Fun State wn
TR 2omt 400 600 L

g vial 1

Run 2.4/ 250 min

i Chromatogram Plot

.800 mL/min

Windows—where you do most of your work

When you first start the Data Acquisition program, the main window appears. You
do almost all of your work within the eight windows of this main window. These
windows provide the tools to set up acquisition methods, run samples

interactively or automatically, monitor instrument status, monitor runs and tune
the instrument.

Chromatogram Plot Method Editor Spectrum Plot Actuals
window window window window

[E=mlECE =

m 008: Run Time. 237 min

; SpectrumPlot

x
— Q00 Spectum
g L 3109
5 sook
;W it 629658 e
eig 30 30
o 0~ s i
1 15 2 " 100 150 200 250 300 350 400
niz(am.)
i MethodEditor x
Wl W B [[eeabamplem o Apply

Propeties DA Samgler  Sampler Preleainent  Binay Pump  Calumn Comp. VWD | g

Tune fle Stop ime Acquisition | source | Ctromatogram | instrument | Dignosties |

atures tune sl Sean segnents

o o SegmentName | StatMass EndMass | Soan Time | Fragmentor | Cel Accflerstor Voltage | _Polaiy
> | 100] 400 500 100 7|Positve

Ton souce Time fiteing

ESI F 007 min

Time segments

Start Deta | Deta
o || 8=t SeanType | DivWabe | 0efe | B8 | Storet
S N = o B B |

[am  ovcesss [igae  mefoyce

Scan parameters

Step siee: ] o
Data storage: Frofie
Thieshold o

WarkList Method Editor | Gample Fiun |

The Sample Run and Worklist windows are tabbed here. These three windows are “sharing” this space. You
click the tab to switch to a different window.

Figure 1 Main window of the Data Acquisition software program
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Getting Started

Show/hide the windows You can show one window at a time on the screen or up
to seven windows. You can never hide all of the windows. To show or hide a
window, you click the commands in the View menu. You can also hide a window by
clicking the X icon in the upper right corner of the window.

When you click a window, the title of the active window changes to a different
color. Press F1 to obtain help on the active window. You can also drag a window
border to resize the window. If you double-click the title of the window, the
window “floats” outside of the main window. You can double-click the title bar
again to “dock” the window. You can also float and dock the window when you
right-click the title of the window and click Floating.

Instrument Status window With this window you view the status of each device
configured with the instrument: Error, Not ready, Pre-run, Post-run, Running,
Injecting, Idle, Offline, or Standby. You also set non-method control and
configuration parameters for the LC devices and the MS instrument.

This window displays the current status of each device both as text and by its
color-coding;:

Table 1 Color Coding in the Instrument Status Window

Color Status

Red Error

Yellow Not ready

Purple Pre-run, post-run, Waiting

Blue Running, injecting

Green Idle

Dark gray Offline

Light gray Standby (for example, lamps off)

 Instrument Stalus X

O [ T P T | L R

- 1 JEME ] rllll 09 | © rnll 990 O rnllll 090 & Run I © O Run I

== 3 & § @ L aFe

¥
\2 OpL 400 €00

LS 0.800 mL/min

i Vial L

250nm

Run 2.44 / 2.50 min
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Getting Started

Actuals window With this window you view the current value of selected
instrument parameters. See “Set up to view real-time parameter values (actuals).”
on page 15 for more information.

! Actuals x

Parameter Value
QQQ: Not Ready Text Long
QQQ: Not Ready Text Short

QQQ: Gas Flow 5.0 i/min
QQQ: Eror State no_error
QQQ: Instrument State background_scauisition
QQQ: lon Mode AJSESI

Chromatogram Plot window With this window you monitor the chromatogram
plots in real time. These plots can be user-defined signals and/or instrument
parameters. You select the plots in the Chromatogram tab in the QQQ tab in the
Method Editor window.

i Chromatogram Plot x
Tic
a8 3
288
1E84
..h E T T T
EI M 1 15 z min

Spectrum Plot window With this window you monitor the spectral plot in real
time.

i Spectrum Plot x

000 Spectum |MS [1:MSZ Scan ESI(+. 2.38
BTE0K Area 0 3108
| sooi miz: 310.9
S asoi WAV 07 3329
, Helaht 629658 F . . 3830 3950

100 150 200 250 300 350 400
v v miz(amu)
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Getting Started

Method Editor window  With this window you enter acquisition parameters for

the method. If you click the button, then you can see the tune values in the
Tune Parameters dialog box.

i Method Editor
<l W | B | Q00 Bamplen o Apply
Fropeties DA Sampler  Sampler Fretieatment  BinayPump  ColmnComp. YWD | 000
Tune file Stop time Acquisition | Source | Chvamstosram | instrumert | Disgnostics |
atunes.tune. mil e Scan segments
o (o ] min Seqment Name StartMass ErdMass | ScanTime | Fragmentor | Cell AcceleratorValtage | Polarity
» 100] 00| 500 100] 7|Positive
on source: Time fiering
ESl ~ 007 min
Tine seqments
Start Delts | Deha
@ = SeanType | DivValve | oot | D8 | Stored
v [ 0[M52 5ean ToWs | 40| i ® |
Sieah parameters
Step size: ] anu
Data storage: Frofilz
203 oyolesis [1936  me/oucls
203 4536 Thieshold [

Sample Run window  With this window you enter sample information to run
individual samples interactively, and you can start a single sample run. You can
also specify an Override DA Method and select either Both Acquisition and DA

or DA Only for the Method Type, and then Data Analysis is run as part of the
method.

i Sample Run
>
Sample Addional Information
Parameter Name Paiameter Vake
Hame Samplel Position Yial 1 -
» | SampleID |
Iniection Volume  EETTETEE - pL Override D& Method
Meihod Type Lequisifon Orip
Comment E quilb Time (minl i
Data Fie

[7] &uto Increment

Mame

Path

‘workList | Method Editor ~ Sampls Run

Test_MSScani02d

DiAMassHunler\Data [ |
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Getting Started

Worklist window With this window you enter sample information for multiple
samples. When you run the worklist, the samples are automatically run in the
order listed in the worklist. You can select whether to run Acquisition Only, to run
Both Acquisition and DA, or to run DA only by selecting one of these options for
the Part of method to run in the Worklist Run Parameters dialog box.

| workList
Dvrdd » B
" Sample Name Sample Position Method Data File Sample Type Level Name Comment  Sample Group Info.
1 |Samplet |P1-a1 QQC_Example.m |worklistDatal.d Sample
2 Sample? |P1-A2 Q00_Example.m |WorklistData2 d Sample
3 v [Sampled P1-B1 QQQ_Example.m WarklistDatad.d Sample
4 | v [Sampled ~[[000_Example.m ‘WarklistDatad.d Sample
Worklist

workList | Method Edtor | Sample Run |

Tune window With this window you tune the mass spectrometer. You can use the
automatic tuning algorithms that are provided, or you can manually tune the
instrument. You have to switch to the Tune Context to see this window.

gilent MassHunter Workstation Data Acquisition

[EErrE=]

File View Tools Help
Context: | Tune v | Layout: [Defauttisys) it~ [H - 4 > . Method: | defautt.m Worklist: |
i Tune x
miz: 118.00 118.00 mfz: 2121.80 2121.80
2200 FVWHM: 0.59 10000 FYYHM: 0.59 Autotune Ramps
2000 Height: 2226 o Height: 10196 18
171
1800 00 e
1600
15( =
o o & During an Autotune or Checktune,
2 8 so00
|5 e %10£ some of the parameters are
5 2
E S s000 < 12 A
12 1000 3 212280 =t ramped to determine the best
4000
a0 w0 value.
500 3000 9
o 2000 8
21238 70E
200 e 1000 —
E 9 18 27 36 45 54 63 72 81 90 a9
. 120.01 X Auis
116 17 118 18 120 2120 2121 2122 2123 2124
v miz(amu) ol miz(ams) XK= XValue Y= Y¥alue [Stohs
Autotune | Manual Tune
Polarity Autah
olarity HET [Autotune StatsInstiument 100 Clear Fauls
 Positive [ Startfrom factory defauits [~ Tune Urit Oniy ‘g;ﬁ;';g;ﬁﬂg;‘;;ﬂf:; L
. . Done
Ciitegalive auetBea o) Initializing parameter values : . Done
S Uit 0.7 Wide 1.2 Widest  [25 R?fi?j;ng data for M1 peaks
Tuning Quad 1
Checktune (4l values are in amu) Options . .
Ui ik e This section shows the
Mass ais tolerance  [772 [a50 [ .
I~ Report m/z below 100 current progress|in the
Target Tolerance Taiget  Tolerance Taiget Tolerance
Pesk 7o e [E [ Autotune or Checktune.
% Complete: 50% 100%
rrumm; Quad 1 ‘ [TT1]
If you make changes in the Manual Tune tab, you can print a Checktune
and Autotune report when you click Create Tune Report.
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Getting Started

Step 2. Prepare the LC modules

Read and follow the instructions in the online Help for each of the tasks in the
checklist described on the following pages. While you condition or equilibrate the
column, you can tune the Triple Quad MS.

1 Switch LC stream to Waste.

When you are not acquiring data, you switch the direction of the LC stream away
from the MS ion source and to waste.

If you have the LC connected to a VWD or DAD, you can still monitor the
fluctuations of the VWD or DAD real-time chromatogram before a run.

a Right-click the QQQ device in the Instrument Status window.

k Status

x
Sampler 2 -0 i BinaryPump 2 - [, ColumnComp. 2 - W t QQQ 2-m

(STORENIE ) Idc I ©OQ@ & de N ©OQ@ & Idic N ©© | & Idle N © © Idle I

2.0uL 870 130 StandBy
0.800 mL/min

Calibrant

Collision Gas

Lc

39.99°C 22.54°C

Vent
Pump Down

APPLUV Lamp

b Click LC > Waste.
2 Purge the LC pump.

Follow the directions for purging the pump in the User Guide for your
pump.
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3 Set up to condition or equilibrate the column.

a Type LC parameters, and click the Apply button in the toolbar to download
them to the LC.

Method Editor x
Oy [pfhhs2scantestrn -] o apply |G
Propeties DA HiPSawpler  HP Sampler Pretieatment | Binary Pump | ColumnComp.  DAD 003
Binary Pump (G1312B) m m
Flow, [+] Advanced
[+] Timetable (4/50 events) -
0800 ©  mi/min
 function centric view
Solvents Tinomminl Azl Brw |flom Mo brescue
A 870 | d 000 80 130 0.800 400,00
180 400 B0D 0500 40000
BV 130 . % H2D - 200 400 B0D
Pressute Linits
Mir 000 1 bar M 40000 C bar
Stoptime Pasttime
) As Iniestor/No Limit O oon | e [ Remwe || Cewal || ClxEuny |
@ 500 min ) 200 min | Cut || e || Paste || shitTimes | i

WorkList | Method Edtor | Sample Run

b Right-click an LC module in the Instrument Status window to change any
non-method control parameters, if necessary.

 Instrument Status

Sampler ? H BinaryPump 7 . m|, ColumnComp. 2 _ &

(oo RENIE el 0@ '8 Ide N @@ | & de N @@ & Iclle [

== 2 & § Elae

200L 870 130
B bao o

i Eror Method Hei@A8AbeE] | (Jp==(ID @E=ED 250nm
et D 39.99 °C 2254°C
L suitch off

Bottle Fillings

¢ Monitor the baseline and adjust the plot to make sure the column is
equilibrated and the baseline stable. (See step 4 and step 5 on page 15.)
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Getting Started

4 Set up to view real-time parameter values (actuals).

As you prepare for a run and during a run, you want to see the actual values of
the instrument parameters. You can do this in the Instrument Status window.

a Right-click the Actuals list to see the Setup command.

Actuals x
Paramneter Value

000; Not Ready Text Long

000: Run State prenn

000; High Vac 1.2765 Ton

000; Gas Temp /0

000; Roughac 1.66E+0 Tor

000; Tubo 1 Speed 100.0%

000: Tubo 2 Speed uz

000: Fimware Version £10.07.03

000: Sheath Gas Flow 12.0lmin

000: Sheath Gas Temp 400°C

Binary Pump: Fiipple 022%

000; Instrument State background_scquisiion
i i »

b Click Setup to bring up the list of Actuals available for monitoring.

Actuals Selection Dialog ==
Avallable Parameters Parameters to display
- HiP Sampler . =

&1 Binary Pump

@ Column Comp. G00: Not Ready Test Long

G DAl B0O0: Run State
E E‘uim . 000: HichVac
amp
Callbrant = 000 Ges Temp
Capilary 000: AoughVac E
Capillary Curent 000; Tubo 1 Speed
Chamber Current
Collision Gas G00: Tubo 2 Speed
Cotana olags 00G: Fimare Version
Diverter \ialve: 000: Sheath Gas Flow
s 000 Sheath Gas Temp
Firmware Version
Gas Flow Binary Pump: Ripple e
Gas Temp 7 s 3
Highac
Instnment Stale
lon Mode
o Polarty
lon Saurce
Locked Mode
MS 1 Heater
S 2 Heater
Nebulizer

Not Fieady Text Long
Not Ready Text Shart

¢ Add all the parameter values you intend to monitor, and click the OK
button. Parameters that you may want to monitor include MS values (such
as heater, and vacuum pressure) or L.C values (such as binary pump,
column, DAD, etc.) You can set the background and text color for each
parameter. You can also set a range for the parameters which are numbers.
If the value of the parameter is not within the limits which you entered,
then the background of the parameter is set to red.
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5 Set up real-time plot displays.

As you condition the column, you can set up the displays to monitor the

effluent.

Right-click the chromatogram plot, and click Change.

Chromatogram Plot

x
TIC

375134

] Freeze
375134
375134 Zoom Qut

| Adjust

| Change...
T T t T T T
-20 10 o 10 20 =0 min

In the Edit Signal Plot dialog box, you can select the type of display signal

Edit Signal Plot

Available Signals

[ ——

Einany Fump: Flaw |
Einary Fump: Solvent Fiatio &
Einary Fump: Solvent Fiatio B
Einary Pump: Direction of Fistan
Einary Fump: Direction of Fiston _

rTIC:

(=]

Selectsd Signals

Add >
< Hemnve

" Predictable Range

@ Floating Range

From: :I \-awis range,  |1.192092835¢ :|
To :I Offset: i :| %
Ut y-adiust
™ & ol
window Propttiss
-avis range: [60 ﬂmm
I~ Draw Grid
0K | Cancel Apply
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Step 3. Prepare the Triple Quad instrument

Do a Checktune, Autotune or Manual Tune

1 From the Context list, click Tune.

[E= Agilent MassHunter Warkstation Data Acquisition
File  View  Sample  Waorklist  Method  Toaols  Help

Context: |Acquisition ~| Layout: | Defaultizyshlyt =

tion

Instiument 5 E2iss
EN—— U7

Getting Started

You can see the Instrument Status window, the Actuals window and the Tune
window when you switch to the Tune context. Click Tune in the View menu if
the Tune window is not visible.

Aulnlunz‘ Manual Tune |

Polarity Autotune
 Pasitive I~ Start from factory defauls I™ Tune Unit Only Aulotune

" Negative Target Peak Width
Create Tune

s Urit 0.7 wide  [12 widest  [25
Checkiune [4ll valuss are in amu) Optiors
Uric Wide Widest
Mess ais tolerance 014 050 (L] [~ Report m/z below 100
Checktune:
Target Tolerance Taiget  Tolerance Tagst  Tolsrance

Peak width 0.70 014 120 060 250 125

% Complete 50% 100%

[Etatus [

2 Click Checktune to evaluate if the MS parameters are within the limits to
produce the specified mass accuracy and resolution. Checktune takes
approximately 3 minutes to run for each polarity.

If the current tune file was last tuned with the Fast Scan Autotune, then the
Checktune algorithm only checks MS2. If the current tune file was last tuned
with Autotune, then the Checktune algorithm checks both MS1 and MS2.

If the current tune file was last tuned with the Fast Scan Autotune, then the
Fast Scan check box is marked on the Manual Tune tab.

Do a Checktune regularly.

You can run a Checktune with the following sources: ESI, AJS ESI, MMI and
HPLC-Chip.

If Checktune passes, then skip to step 5.

If Checktune fails, then you can try using the Manual Tune tab to fix the
problem. See the next step.

Agilent 6400 Series Triple Quadrupole LC/MS Quick Start Guide
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Getting Started

3 Try the following quick changes to get Checktune to pass.
a Click the Manual Tune tab.
b If the failure occurred in MS1, click the MS1 tab. Select the Peak Width
based on which resolution failed in Checktune. You can select Unit, Wide,
or Widest. Then, click the Adjust Gain & Offset button.

Aufotune  Manual Tune
% Calibrani o € LC-5MS @ LO->Waste Funrel | Optics  MS1 | Colision Cet | M52 | Detector | Fies | acquistion |
on Source M1 parometers Gan/offsel fidad
c Cuotl[i5 s (T
(e [ Feaiah [ ]
(‘ s [f205 amu wiahos1 [ i
@ Posiive Scan Tume =
N 51 Profile d " Scan From |50 w [1400  Seep|01 ‘Width Offset 1 [EIEJ
cgalive Parameters
& Profis Enabled | Mess | Window i Giain | A
B0\ 2 ZONRC M Ofet 1 [127
GasFlow |19 190 Imin
Adpust Gain & Offset
Nebuzer [20 B0 e Q
Cotay [0 v [ w [@E v ws10c v
Chambei Posthitei DC 1 2 v
Current EEES Rlamp parameter
Nezdle  [fsm0 —
E | CellAccelv <] Fom [0 3 w [I7 s [E me Ramp
Sheath [
o Temp [550 26 ¢
S0 [Farameter Vabes Sent [B-MzssHunter T ur\ GGG 64508 atunes TUNE ML I™ FastSean
et [T [0 i
Gas Flow il

¢ If the failure occurred in MS2, click the MS2 tab. Select the Peak Width
based on which resolution failed in Checktune. Then, click the Adjust Gain
& Offset button.

d If the Adjust Gain and Offset passes successfully, then save the autotune
file. Click Manual Tune. Then, click the Files tab, and click Save.

e Click the Autotune tab.
f Click the Checktune button.

If Checktune fails again, you must run an Autotune, which is described next.

4 Click Autotune to tune the MS automatically (approximately 30 minutes for
each ionization mode for all models except the 6490 and the 6495. The 6490 and
6495 take approximately 25 minutes per ionization mode.). The system
automatically changes different tune parameters to tune the MS. You only do an
Autotune when it is necessary.

For all instruments except the 6490 and the 6495, you can run an Autotune
with the following sources: AJS ESI, MMI, and HPLC-Chip. With the 6490 and
6495, you can only run an Autotune with the AJS ESI source.

If Autotune fails, then you mark the Start from Factory Defaults check box.
Then, if you click Autotune, the instrument is tuned starting from the factory
defaults (approximately 30 minutes for each polarity for all models except the
6490 and the 6495. The 6490 and 6495 take approximately 25 minutes per
ionization mode.).
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Checktune and Autotune reports are automatically generated after Autotune
completes successfully. If Autotune fails, no reports are printed. You can check
the progress box in the lower right side of the Autotune tab to see the reasons
why the tune failed. Then, you can either fix the problem, or call the Agilent
service engineer and provide this information.

If Autotune fails or you assess that the Triple Quadrupole MS needs custom
values entered for its tune parameters, you can manually tune the instrument.
If you cannot get the instrument to tune successfully, then please call your
Agilent service engineer.

[ Cebanton € LEoMS @ LC>Waste Opiics | st | coison cet | 1s2 | Detector | Fies | acquiston

lon Source Optics parameters Dynamic Ramp Table: by Coxfat
= Fragmentor  |135 W Lens1 DC 37 W fEsro
@ Positive Sean Type: Lens2AFOn  Lens2 AF Off T
= aluz
 Negative MS1 Pofle El Skinmer v Lem2dc 12 v 18
Gas Temp [300 3 ®
GasFlow [6 00 lmin OctopleRF B0 v [ Lens2RF [01 v
Nebulzer [15 10 psi
Copilay [000 v [3 m [® v Octopole DC [5 Vo Lens2fF Phase [180  °
Chamber
Current 1400 A
Ramp parsmeter
Cell docel V +| Fom [0 o8 by 02 fﬁzhng 25 ms Ramp
Urit
[Parameter values Sent | \MassHunter\Tune\ A B3AGE4208\atunes tune. kil ™ Onp

5 Optional. Click the Fast Scan Autotune Only button if you want to tune for
Fast Scan. You only do this step if the Autotune results are acceptable.

Fast Scan acquisition is only supported on the 6490 with two of the scan types:
MS2 Scan and Product Ion scan. Fast Scan autotune only tunes with the Wide
(1.2) resolution, Samples set to 1 (on the Manual Tune > Acquisition Tab), and
the step size must be 0.2. The scan time in the Acquisition tab is generated
automatically based on the step size and the mass range.

Fast Scan acquisition is not supported for the 6495. Instead, you achieve the
faster scan rate by increasing the step size to 0.3 m/z.

6 From the Context list, click Acquisition.

Switch LC stream to MS
e After you condition the column and tune the Triple Quad MS, you switch the LC

stream from Waste to MS. See “Switch LC stream to Waste.” on page 13 for how
to do this.
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Monitor MS baseline and spectral displays

If you did not monitor the LC baseline with a VWD or DAD, make sure that the
Triple Quadrupole baseline is stable, and no spectra of interfering intensity
appear in the display.

If you did monitor the LC baseline with a VWD or DAD, you change back to the
default Triple Quad displays.

1 Right-click the chromatogram plot, and click Change.

2 Select the MS signal, and click OK.

View the system loghook for events and errors

As you prepare the instrument, you may run into an error that you want to
troubleshoot. You do this through the System Logbook Viewer.

e C(Click the Log icon ( flﬁ ) in the toolbar of the Data Acquisition window, and
view the logged events.

¢ Or click Tools > System Logbook Viewer.

e Or right-click the icon in the system taskbar. First, click Enable
Notification. Then, right-click the LOG icon and click Configure. The system
can notify you of new errors and warning by showing messages from the
taskbar.

When the System Logbook Viewer is open, you can select the time period to keep
System Logbook entries. You can set the value from 1 week to 1 year. To do this,
you click Tools > Purge Settings. The System logbook purge dialog box opens.

[t Logbook Viewer- C:A\MassHunter\SysLogbook.log [o =] =]
File Edit View Tools Help

= . = 13 System logbook purge ]
= @@ aY
Ll EventTypiEventSouCated 1. oiog before purging System Loghook enties 0K il
© 041020141158 (Nomal  AcaEng FunS
© 04102014 1156 ol Acgfna  AunS|  [Twesk =]
o 04/10/2014 11:44:7 Narmal AcgEng Fun 51 1= B

2y 04/10/2014 11:38 ¢ Waming | AcgEng
€ 04/10/2014 1138 Enen AcoEng
o 041020141137 Momal | Spstem Startug

[P RPAA A1 ) Conberns

Status 410/2014 12.07 P
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Step 4. Set up and run an acquisition method

Read and follow the instructions in the online Help for each of the tasks described
on the following pages.

Also, do Exercise 1 of the Data Acquisition Familiarization Guide to learn how to
set up and run an acquisition method.
1 Set up the method:
a Type the values and settings for each of the tabs below.
b Optional. If you want to download the settings to the instrument, click
Apply.
¢ To save the method, click Method > Save As.
d Name the method and click OK.
2 Enter values for all of the LC modules configured for the instrument.

Wethod E ditor X
O v Wl B [phsszscantestm -] & aply |G
Fiopeties DA HiPSampler  HIP SamplerPretieatment | Bina Fump | CounnComp.  DAD Q0O

Binary Pump (G1312B) m m

Flow +| Advanced
+| Timetable (4/50 events) -
0800 ml/min
function centric view

Sabvents Tinefminl < |A[x] B[zl flow. . Max Fressue

A % H20 - 000 &0 130 0.800 400,00

180 400 £O0 0500 400,00

BV 130 : % H20 - 200 400 E00
Pressure Linils

Min 000 © bar Max 40000 © bar
Stoptime Pasttime

A InjectorNo Lni i | add || Remove || ClearAl || CearEmpy |
@ 500 . mn @ 200 © mn | ci || o || Pate || ShittTimes | min

‘workList | Method Editor | Sample Run

Make sure when you type the MS parameters on the next page that the tune file is the one
that you want to use with the acquisition.
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3 Enter the Triple Quadrupole parameter values.

a Select the Scan Type from the list in the Time segments table. The Scan
segments table is cleared when you change the Scan Type. The parameters
available on the right change depending on the Scan Type.

If you are changing the Scan Type from MRM to Dynamic MRM or to
Triggered MRM, you can copy and paste the transitions from the original
Scan segments table to the Clipboard and then to the new Scan segments
table. See the online Help for more information.

b Type in any Acquisition values you want to change. You can enter multiple
Scan segments.

You cannot set the fragmentor voltage in Acquisition if the instrument type is
an Agilent 6490 or an Agilent 6495. It always uses the value in the tune file.

{ Method Editor
O v W W B [Ms2scanMethod.m -] Zaply B
Properties DA | @a@
Tune file Stop time Acauisition | Source | Chromatooram | instrument | Diagnostics |
atunes ture.aml & Nolirit/as Punp Scan seqments
Browse & (ol min E”gzﬁg”” Compound Name | 15TD? P‘ﬁi“ﬂ“”' MST Res P‘f:n““ MS2Res | Dwell | Fragmentor | Colision Energy EE"CS‘T
s E— » | Bompoundt = 350 unit [ 200 Uni | e 1385, 0
ESI = [ Peakwidth  [0.07  min
Time seamens
Statt Dela | Dels
w | Fat SeanTupe | Divvabve ot (Dol®) | Stored

1 ‘ n\ jTuMs ‘ n\ u| ~ ‘

2 ToWaste i 4

Neuiral Gain

ViorkList 'Method Editor | Sample Run |

4 Set up to change Triple Quad MS parameters with segments and scans:

a To add a segment, right-click anywhere in the Scan segments section to
bring up the Scan Segments shortcut menu, and click Add Row.

b Type the parameters for each Scan segment.

A:quisilinn} Source | Chromatogram | Instrument | Diagnostics |

Sean segments:

Fopeond | CompoundName | 15TD7 | ST < MSTRE T o, Dolson | Cellgoesionor | potay
» Suladmethosine r 311 |Unit Dt 2 7|Postive
sultscHoropyridazive | [ 285 Uni e 8 7[Postive
slamethazine a] 2751 Ui 12 7|Fostive
aullamethizale r 271 Unic e T 0 7|Posiive

Update DMRM Method .
Cut

Copy

Paste

Paste from Clipboard
Fill Down

Fill Column
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5 Set up signals for the Chromatogram plot:

a Click the Chromatogram tab.

Getting Started

b Select the Chromatogram Type, and type other plot values.

Chiematograms
Chiomalogram Type:
TIC

Label

TIc

Ewracted Masses  Precursorlon | Product lon

Aceistion | Source I:hmmatngmm} Instrument | Disgnosties |

Excluded Masses

0

Offset| fRange

1E+07

MR

MR

360

200

1000

EIC

EIC

200

1000

MS1EIC

MS1EIC

350

200

1000

MEZEIC

MEZEIC

360

200

1000

BPC

200

1000

MS1BPC

200

200

olo|lelole|ale

1000

MEZBPC

360

1000

6 Set up the Stored instrument curves in the Instrument tab. In the Qualitative
Analysis program, you can display these values in the MS Actuals window for
the current spectrum. With the Triple Quadrupole, the values in the MS Actuals
window in the Qualitative Analysis program are the values that you save in the

Instrument tab.

a Click the Instrument tab.

b Select the Stored instrument curves. These curves can be shown in the
Chromatogram Results window in the Qualitative Analysis program. The

values can be seen in the MS Actuals window.

Ayailable instrument curves:

Capilary
Capillary Cunent
G Flow

Gas Temp
HighVac

MS1 Heater

M52 Healer
Pump] Curent
Pumpz Cunent
Rough Vac
Sheath Gas Flow
Sheath Gias Temp
Turbo! Speed
Turbo2 Speed

[=1 L&l =] [~

Aouistion | Sowee | Chromstogram In:lrumenl] Diagnostios. |

Stored instrument curves

_hamber Cument,

Mebulizer

7 Set up the data analysis (DA) parameters.
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A method can contain qualitative analysis parameters, quantitative analysis
parameters or both. A Data Analysis method is a method that contains data
acquisition parameters with either the Qual Automation check box marked on
the Qual tab or the Quant Automation check box marked on the Quant tab.

a Click the DA tab.

b Optional. Mark the Qual Automation check box. The name of the
current Qualitative Analysis method is shown in the box. If you want to
change the Qualitative Analysis method that is connected, click the
button to select a different method. When the Data Acquisition method
is saved, the Qualitative Analysis method that you selected is copied or
linked to the Data Acquisition method.

Qual | Quant
Qual Automation
Qualitative Analysis Method
C:\MassHunter\Methods\defaut m

o) Lk @ Copy

Change to Method: =

View Method

¢ Optional. Click the Quant tab. Mark the Quant Automation check box.
The name of the current Quantitative Analysis method is shown in the
list. If you want to change the Quantitative Analysis method that is
connected, click the D button to select a different method. When the
Data Acquisition method is saved, the Quantitative Analysis method that
you selected is copied or linked to the Data Acquisition method.

d Optional. Mark the Generate Report check box on the Quant tab. Then,
you select the Template File to use. If you want to print the report,
mark the Print to default printer check box. You can also mark the
Publish check box to create a CSV file, a TXT file, or a PDF file.
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Quant Automation

Quantitative Analysis Method
Select a method P

® Link © Copy
Change to Method: C:\MassHurter\Data\MRM_to_DMRM\MRM_to_DMRM quantmethodsml .. |

View Method
Generate Report
Template Fle C:\MassHurter'Report Templates'Quant'en-US\Letter\ESTD\Parts_Grapl .. |
Print to defaut printer
Publish csv -

8 Set up the Properties for this method.
a Click the Properties tab.
b Click the D button to select the Pre Run Script.
¢ Click the D button to select the Post Run Script.

d Type the Description for this method.
9 Save the method.
a Click Method > Save As or Method > Save.
b If necessary, name the method and click OK.
10 Set up and run interactive samples:

a Click the Sample Run window. By default, it is tabbed with the Worklist
and Method Editor windows.

b Enter the Sample Name, the Data File Name, the Path and other values.

¢ Enter the Additional Information. You can change the value of the
parameters in the Additional Information list.

i Sample Run

>

Sample Addtional Information
Parameter Name Farameter Value 4

MName Sample1 Posttion [No Injection L]
Sample 1D

Injection Volume |As ethod ul Gveride DA Method | C:\MassHunteriMethods PAH_Link
Sample Type Sample =

Coase Method Type Acauisition Only

— Ealance Override ¢ No Override
Equilib Time (min) | 0

[¥] Auto Increment. » | RunType Standard Run

Name f5ampie0006.d| | View Data

Fath Ci\MasshurterData .|

»
=

Worklist | Method Editor Sample Run
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You can run a Data Analysis method from this window by selecting Both
Acquisition and DA or DA Only for the Method Type. In addition, you have
to set Override DA method to indicate which Data Acquisition method
contains the DA (Data Analysis) method to execute. You always have to do
this.

d To start the single sample run, click the Run button (h) in the Sample
Run window or the Run button ( ) in the main toolbar.

You can run the single sample in either locked or unlocked mode. When the
mode is locked, no one can change the method or sample parameters during
a run. You also cannot overwrite this data file in the Data Acquisition
program. The Lock button () in the main toolbar indicates that locked
mode is on.
11 Set up and run worklists

a Click the Worklist tab to show the Worklist window. If the Worklist window

is not visible, click View > Worklist.

b Right-click the upper left corner of the worklist.

§ Worklist

O vie » B —

jample Position Method Data File Sample Type

Add Multiple Samples...
Add Sample
Add Script..

Sample

Copy Row(s)

Delete Rows)
Add Colymn(s)...
Show/Hide/Order Columns...
Text Size »
Add Worklist...
Worklist Run Parameters...
Import Worklst...
Wrap

v Track Worklist Run

Worklist

"Workiist | Method Editor | Sample Run |

Click Add Multiple Samples. The Add Multiple Samples dialog box opens.
Enter all the information on the Sample Information tab.

e Click the Sample Position tab to specify the sample vial locations (make
sure the specific sample tray type has been configured by right-clicking the
autosampler device image).
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Add Multiple Samples =
Ssmple Information | Sample Position
=
Select Well-plate or Vial Tray  Plate/Tray Type
Select Tray “SEAgilent” [=]
E1- Well-plate Trey
£ v £ Selection Origin Block Increment
Plate 2 @ Toplet " Topright @ Row major
£ Vil Tray \ALS £~ Column major
Tray A € Botomleft  Botlomright  ~ Sarpentine
Tray B
E1-CTCPAL
Plate 1 Number of samples Number of replicates
Plate 2 g 1
Plate 3
Viell-plate/Tray
i 2 3 4 5 6 7 8 L] 10 11 12
- [GXOZOJ0)]
[@joja)o;
c
D
E
F
G
H
oK Cancel

f Specify the locations, and click the OK button.

g To set up the worklist run, right-click the upper left corner of the worklist,
and click Worklist Run Parameters.

h Click the Page 1 tab.

Type the paths for the method and data files.
Click the Page 2 tab.

Review the information and click the OK button.

To start the worklist, click the Run Worklist button (([[3»)) in the main
toolbar or the Run button (h) in the Worklist window

—_ =

You run the worklist in locked or unlocked mode. When the mode is locked, no
one can change the method or the worklist while the worklist is running.

To use an acquisition method that has a different DA method than the method entered in
the worklist, show the column called Override DA Method in the worklist by using the
Show/Hide/0Order Columns dialog box. In this column, type the name of another method
containing the DA parameters you want to use for the sample. The DA part of this method
is used instead of the DA part of the current method.

You can also type the name of this method in the Add Multiple Samples dialog box.
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Step 5. Review results with the Qualitative Analysis program

Use the Qualitative Analysis program to do these tasks and more:
Review results for acquisition method development
Select the most appropriate precursor and product ions for MRM analyses
Find compounds
Identify compounds
Do molecular feature extraction

Do the exercises in the Qualitative Analysis Familiarization Guide to help you
learn how to use the Qualitative Analysis program.

Do Exercise 1 of the Data Acquisition for Triple Quad Familiarization Guide to
help you learn how to use the Qualitative Analysis program to develop acquisition
methods.

Also, refer to the online Help for the Qualitative Analysis program to learn how to
do more operations to analyze your data.

Step 6. Analyze data with the Quantitative Analysis program

Another primary tool for analyzing and reporting Triple Quad LC/MS results is the
Quantitative Analysis program.

¢ Do the exercises in the Quantitative Analysis Familiarization Guide to learn
how to quantitate the acquired data files:

Set up a batch and a method to automatically quantitate a set of samples

Review results by learning how to view and use the Batch-at-a-Glance results
screen

Identify and use outliers to change the method and requantitate the data
using a better calibration curve fit or other more appropriate settings

Also, refer to the online Help for the Quantitative Analysis program to learn how
to do more operations to analyze your data.
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Step 6. Analyze data with the Quantitative Analysis program
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